Configure Your Yamaha Console To MIDI Control
The Waves SG MultiRack System

March 6, 2013
### Table of Contents

Welcome to the Yamaha/Waves Midi Control Manual.......................................................... 3

1.0 - The Possibilities: ............................................................................................................ 3

2.0 - MIDI/USB Connections: .................................................................................................. 3

3.0 - Setup YAMAHA PM5D MIDI / USB Connections .......................................................... 5
   3.1 – Setup the required MIDI/USB connections: .............................................................5
   3.2 - Setup the PM5D MIDI Remote Settings: .....................................................................7

   4.1 – Setup the required MIDI connections on the Yamaha M7CL console: ...................10
   4.2 - Setup the M7CL/LS9/CL Series MIDI Control Change Settings: ..........................13

5.0 - Setup YAMAHA DM1000/2000 and O1V96/O2V96 MIDI / USB Connections ............... 15

6.0 - Configure Your SG MultiRack System for MIDI Control: ........................................... 18

7.0 – Mapping the MultiRack Remote Controller Editor Window ........................................ 21
   7.1 – Automatic Mapping of the MultiRack Remote Controller Editor Window: ...............21
   7.2 – Manual Mapping of the MultiRack Remote Controller Editor Window: ..................23

8.0 Implementing the Yamaha Console MIDI mapping with the SG MultiRack: ...................... 26

Appendix.................................................................................................................................. 28

   A. Remote control assignments of Yamaha PM5D, DM2000, DM1000 consoles...............28
      A.1 – Plug-in and Racks Parameters Control.................................................................28
      A.2 - MIDI functions Assigned to User Defined Keys of these Yamaha consoles ...........29

   B. Remote control assignments of Yamaha M7CL, LS9 and CL Series consoles. ..............30
Welcome to the Yamaha/Waves Midi Control Manual

The following range of Yamaha digital mixers have the ability to interface with Waves to remotely control the plug-ins and Snapshots of the Waves MultiRack SoundGrid:

PM5D • M7CL • LS9-32 • LS9-16 • DM2000 • DM1000 • 02R96 • 01V96 • CL Series (CL5/CL3/CL1)

To allow control of the MultiRack SoundGrid software from the mixer, some MIDI setup is required. This process varies depending on the model of mixer, so each type will be described in turn.

This is a step-by-step instruction that will allow you to fully control your SG MultiRack system via your Yamaha console.

1.0 - The Possibilities:

1. Full Control of SG MultiRack’s Waves Plug-ins and Rack functions via your Yamaha Console.
2. Sync between the Yamaha Scene Change and MultiRack Snapshots change.

2.0 - MIDI/USB Connections:

1. Connect a MIDI cable between the WSG-Y16 card MIDI IN port and the Yamaha consoles MIDI OUT port.
2. Connect a USB cable between the Yamaha Console USB out port and the Computer running your SoundGrid MultiRack software.

**Technical Note:** When using a USB connection please install Yamaha’s USB-MIDI Driver software. Please download the corresponding USB-MIDI Driver to your SG MultiRack Computer from [Yamaha’s Firmware and Software](#) page.

**Connections Required:**

PM5D, DM2000, DM1000, 02R96, 01V96 – USB and/or MIDI

3.0 - Setup YAMAHA PM5D MIDI / USB Connections

3.1 – Setup the required MIDI/USB connections:

Follow these instructions to setup the required MIDI/USB connections to control Waves SG MultiRack from your Yamaha PM5D.

1. In the DISPLAY ACCESS section, press the MIDI/REMOTE key several times to access the MIDI SETUP screen shown below.

2. Switch the PROGRAM CHANGE under the Tx column to ON.

3. The PM5D PROGRAM CHANGE setting under the MODE column should be set to SINGLE.

4. The MIDI PORTS should also be set in this page.
   a. If MIDI is used, set the MIDI PORT under the Tx column to MIDI. Set MIDI REMOTE Output Port for BANK A to MIDI, as shown below.
b. If MIDI is used, set the **MIDI PORT** under the **Tx** column to **USB Port 3**. Set **MIDI REMOTE Output Port for BANK A** to **USB Port 2**, as shown below.

5. The **SINGLE MODE MIDI CH > Tx** should be set to **1**. This will be the Midi channel for snapshot recall. Please view Chapter 6 Step 3 for more information.

6. In the **MIDI PGM CHANGE** tab, make sure that under **PROGRAM CHANGE SETUP** the mode is set to **SINGLE** and that the **TX** is **ON**.

Your Yamaha PM5D console MIDI / USB connection is now set.

The SG MultiRack Snapshot's selection will follow the PM5D console Scene selection.

If you Recall Scene 1 on the PM5D console it will Recall Snapshot 1 in your SG MultiRack.
3.2 - Setup the PM5D MIDI Remote Settings:

**Technical Note:** The initial settings for the PM5D MIDI Remote are not suitable for controlling SG MultiRack and must be edited. Each control that is required should be converted into the format as shown below.

<table>
<thead>
<tr>
<th>Control</th>
<th>Channel 1</th>
<th>Channel 2</th>
<th>...</th>
<th>Channel 24</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENCODER ON</td>
<td>B0-00-SW-END</td>
<td>B0-01-SW-END</td>
<td>B0-17-SW-END</td>
<td></td>
</tr>
<tr>
<td>ENCODER</td>
<td>B1-00-ENC-END</td>
<td>B1-01-ENC-END</td>
<td>B1-17-ENC-END</td>
<td></td>
</tr>
<tr>
<td>CH ON</td>
<td>B2-00-SW-END</td>
<td>B2-01-SW-END</td>
<td>B2-17-SW-END</td>
<td></td>
</tr>
<tr>
<td>FADER</td>
<td>B3-00-FAD-END</td>
<td>B3-01-FAD-END</td>
<td>B3-17-FAD-END</td>
<td></td>
</tr>
</tbody>
</table>

To save programming time please follow these instructions below to load Midi Preset file into the PM5D console.

Here is a link to the Waves for Yamaha page, under Yamaha MIDI Remote Control Guide download the MIDI Templates.
Unzip the Waves Templates file, in the Waves Templates folder there is a PM5D Console file named WAVES-RM.PM5.

There are two ways to load this file into the Yamaha PM5D console.

1. Via Studio Manager Online with the PM5D.
2. Copy the file onto a Memory Card, either PCMCIA card or Compact Flash (CF) in a dedicated adaptor.

Suitable memory cards are either PCMCIA card or compact flash (CF) in a dedicated adaptor. Yamaha only recommends and supports cards in the FAT16 format, most cards up to 2 GB work fine for file transfer.

To load the file from an Online Studio Manager simply load run the WAVES-RM.PM5 Console file. If it does not load then your Studio Manager is not Online with your PM5D.
To load the file from a Memory Card follow these instructions:

1. Insert the Memory Stick to the designated slot on your console.
2. Access the LOAD screen from DISPLAY ACCESS > UTILITY > LOAD.
3. Make sure all the data within your PM5D is backed up or no longer needed.
4. Scroll to the WAVES-RM.PM5 and click on LOAD.

Once this file is loaded, the PM5D MIDI Remote Settings should setup as described above.

For any additional information on how to load a Yamaha PM5D Console file please refer to the pm5d_quick_guide_part3_en.pdf file page 23.

If you don’t have the time or resources to get the WAVES-RM.PM5 file loaded onto the PM5D console, please follow these instructions to setup the required Settings to control Waves SG MultiRack.

Check under BANK SELECT and see maybe one will have these exact setting, go through Bank’s A-D.

1. In the MIDI/REMOTE, under the MIDI REMOTE tab, press the INPUT CH switch under ASSIGN TO CH STRIP SECTION to convert the console’s faders, on switches and encoders to MIDI REMOTE mode.
2. Under **ENCODER ON** and **CH ON** make sure the **Latch** is highlighted.

3. Under **ENCODER ON, ENCODER, CH ON** and **FADER**, should be setup to transmit Control Change messages in the format: **B*-00-SW/ENC-END** as shown in the picture above.

4. Repeat 2-3 for **REMOTE CH 1-24**.

This concludes the programming on your Yamaha PM5D console.  Click Here to get to Chapter 6 to complete the SG MultiRack Setup
4.0 - Setup YAMAHA M7CL/LS9/CL Series (CL5/CL3/CL1) MIDI Connections

*Technical Note: When using Ethernet connection between Yamaha M7CL/LS9/CL Series and your SG MultiRack computer the Yamaha’s Network-MIDI Driver software is required. Please download and install the Network-MIDI Driver to your SG MultiRack Computer from Yamaha’s Firmware and Software page.*

Make sure that the Yamaha M7CL/LS9/CL Series consoles is Online with your SG MultiRack computer, using the before you continue with these instructions. For any additional information on how to get the Yamaha M7CL/LS9/CL Series consoles Online please refer to the M7CL/LS9/CL Series console’s manual file.

4.1 – Setup the required MIDI connections on the Yamaha M7CL console:

Follow these instructions to setup the required MIDI connections to control Waves SG MultiRack from your Yamaha M7CL/LS9/CL Series console.

1. Depending on which Yamaha console you are using:
   a. **LS9** - In **DISPLAY ACCESS** press the **SETUP** button repeatedly to access the **MISC SETUP** screen, and then click on **MIDI SETUP**.
   b. **M7CL/CL Series** - On the Touch Screen, click on the **SETUP** button on the bottom right corner of the screen, and then click on **MIDI**. In the CL Series it will show as **MIDI/GPI**.
2. Under the **MIDI SETUP** tab, set the **PORT/CH** under the **Tx** column to **MIDI** and set it to **CH1**.
3. Switch the **PROGRAM CHANGE** and **CONTROL CHANGE**, under the **Tx** column, **ON**.
4. Under **MODE** set the **PROGRAM CHANGE** to **SINGLE**.
5. Under **MODE** set the **CONTROL CHANGE** to **TABLE**.

6. Under **MIDI > PROGRAM CHANGE** tab on M7CL/CL Series or under the **MISC SETUP > PROGRAM CHANGE** tab on LS9, make sure that under **PROGRAM CHANGE SETUP** the mode is set to **Single** and that the **TX** is **ON**.

Your Yamaha M7CL/LS9 console MIDI connection is now set.
On the LS9 Click on SCENE MEMORY under DISPLAY ACCESS. Now DATA ENTRY section would let you switch between the LS9 Scenes. Click on ENTER to switch
4.2 - Setup the M7CL/LS9/CL Series MIDI Control Change Settings:

The Yamaha M7CL/LS9/CL Series consoles do not have the MIDI REMOTE functionality of the other consoles, but they do have MIDI Program Change and Control Change tables.

Some parameters that are not needed for audio can be mapped to MIDI Control Change messages and used to control the Plug-ins.

For example, use spare Mix or Matrix Sends. In this example, sends to Mix 16 from Input Channels 1-8 are used, but a different Mix or even Matrix send could be used.

In the M7CL/LS9/CL Series MIDI CONTROL CHANGE table, assign the parameters for controlling the plug-in parameters to the Control Change numbers which would fit with the supplied MultiRack Remote Controller Editor M7CL.mrrc template file, as shown below.

Control Change 103 to 110 are used for the ON switches and Control Change 111 to 118 are used for the Fader. All under MIX 16 of the Yamaha M7CL/LS9/CL Series console.

More on how to load this file onto your SG MultiRack computer will be covered in Chapter 6.2.
3. A green edit window will appear, named **MIDI CONTROL CHANGE [#103]**.
4. Under **MODE** column select **MIX/MATRIX SEND**.
5. Under **PARAMETER1** column select **MIX 16 ON**.
6. Under **PARAMETER2** column select **CH 1**.
7. Click on **OK**.
8. Repeat steps 2-7 to set the **CH 2-8** for **CONTROL CHANGE NO.104-110**.

**Please Note:** For **MIDI CONTROL CHANGE [#104]** choose **CH 2** under **PARAMETER2**, For **MIDI CONTROL CHANGE [#105]** choose **CH 3**, and so on up to **MIDI CONTROL CHANGE [#110]**.

9. Now select **Control Change NO.111**.
10. Under **MODE** column select **MIX/MATRIX SEND**.
11. Under **PARAMETER1** column select **MIX 16 H** (don’t choose **MIX16 L**, which is low value data).
12. Under **PARAMETER2** column select **CH 1**.
13. Click on **OK**.
14. Repeat steps 9-13 to set the **CH 2-8** for **CONTROL CHANGE NO.112-118**.

**Please Note:** For **MIDI CONTROL CHANGE [#112]** choose **CH 2** under **PARAMETER2**, For **MIDI CONTROL CHANGE [#105]** choose **CH 3**, and so on up to **MIDI CONTROL CHANGE [#118]**.

In addition, the M7CL.mrrc file also uses the “**Prev Page”** and “**Next Page”** functions. These functions are set to **MIDI CONTROL CHANGE [#102]** and [#119]. They will allow you to browse between the plug-ins parameters control pages. These functions can be assigned to Mix16 ON for channels 9 and 10 respectively.

This concludes the programming on your Yamaha M7CL/LS9/CL Series console.

[Click Here to get to Chapter 6 to complete the SG MultiRack Setup](#)
5.0 - Setup YAMAHA DM1000/2000 and O1V96/O2V96 MIDI / USB Connections

Follow these instructions to setup the required MIDI/USB connections to control Waves SG MultiRack from your Yamaha DM1000/2000 or 01V96 / 02V96 console.

1. On the DISPLAY ACCESS section click on the MIDI button repeatedly to access the SETUP tab.

2. In the SETUP tab switch the Tx PROGRAM CHANGE to ON.

3. On the DISPLAY ACCESS section click on the SETUP button repeatedly to access the MIDI/HOST tab.

4. The CHANNEL column under Tx should be set to 1. This will be the Midi channel for snapshot recall. Please view Chapter 6 Step 3 for more information.
5. Set the MIDI PORTS in this page.
   a. If MIDI is used, set the Tx MIDI PORT to MIDI, and set REMOTE under SPECIAL FUNCTIONS also to MIDI.
   b. If USB is used, USB Port 2 in the REMOTE under SPECIAL FUNCTIONS, and USB Port 3 in the GENERAL Tx PORT, as shown below.

Please Note: When using Yamaha DM/0 consoles choose Remote 1 under SPECIAL FUNCTIONS. When using O1V96, there is only one Remote Layer.

![DM1000 MIDI/HOST SETUP](image1)

![DM2000 MIDI/HOST SETUP](image2)

Technical Note: The initial settings for the DM/0 and O1V96 consoles conveniently have a perfect setup for controlling SG MultiRack in their initial settings for BANK 4. So No MIDI programming is required!

6. Click on the SETUP button on the DISPLAY ACCESS sections continuously until you get to Remote (Or Remote 1 when using DM/0 consoles). Set the BANK setting to Bank 4 as shown below.
This concludes the programming on your Yamaha DM1000/2000 console.

[Click Here for Chapter 6 to complete the SG MultiRack Setup]
6.0 - Configure Your SG MultiRack System for MIDI Control:

Please follow these instructions to configure your SG MultiRack system for MIDI Control via the Yamaha console you’re working on.

1. Launch **SG MultiRack**, open the **Preferences** window and go to the **Control** tab.
   a. Windows - **Edit > Preferences**.
   b. Mac OSX - **MultiRack SoundGrid > Preferences**.
2. In the **Control** tab, check the required **MIDI In** port:

   a. The **MAC Address** of the WSG-Y16 card is shown, and should be selected if a MIDI cable is used (Usually in cases where Yamaha M7CL or LS9 is used).

   ![Example of a MAC address of the WSG-Y16](image)

   b. If a USB connection is used, select **USB Ports 2 and 3** with the name of the Yamaha Console you’re using. In this example I used the Yamaha PM5D as shown below.

   i. **Yamaha PM5D-2** – Controls MIDI changes for SG MultiRack’s Plug-ins and Rack functions.
   
   ii. **Yamaha PM5D-3** – Sync’s MultiRack’s SnapShoots with the PM5D Scene Control Change.

   ![Example of a “Yamaha PM5D-2” and “Yamaha PM5D-3” USB connection](image)

   **Please Note:** If Midi and USB connections has been used you will see both the USB Ports and Mac Address in MIDI Ports list.
3. The selection box for **Set MIDI channel for snapshot recall** under **MIDI Snapshot Recall** should match the Channel number used for **MIDI Tx** on the console.

To verify which **Tx Port** was set for this function on the Yamaha PM5D, DM/0 and O1V96 consoles, go to the **MIDI SETUP** page on that console, in the individual instructions for each Yamaha console it was set to Channel 1. The Yamaha M7CL and LS9 consoles will also be set to Channel 1.

4. Click **[Apply]**, and a console Scene recall will now be able to trigger a Snapshot recall in the software.

**Please Note**: The MIDI communication is one-way only, from Console to MultiRack! Meaning, Snapshot Recall in MultiRack cannot cause the console Scene to Recall.

5. To prepare the MultiRack software, open the Preferences window again, and select the **Control Setup** tab. Then set the MIDI Pickup Mode to “**Takeover**”.

6. Click **[OK]**. You SG MultiRack is ready for MIDI Control.

In the Next segment we will cover how to set your Midi Control Functions of your SG MultiRack system.
7.0 – Mapping the MultiRack Remote Controller Editor Window

In this section we'll cover the MIDI Mapping of MultiRack's Remote Controller Editor Window.

This is where incoming MIDI messages from the Yamaha console can be mapped to the SG MultiRack software functions.

There are two ways of Mapping the MultiRack Remote Controller Editor window:

1. Loading a *.mrrc Template file:
   a. Here is a link to the Waves for Yamaha page, under Yamaha MIDI Remote Control Guide download the MIDI Templates Zip file.
   b. Unzip the Waves Templates file.
   c. In the Waves Templates folder *.mrrc Template files are available for PM5D, M7CL (also use for LS9), DM2000 (also use for 02R96) and DM1000.


7.1 – Automatic Mapping of the MultiRack Remote Controller Editor Window:

1. In the SG MultiRack software, open the Preferences window and go to the Control Setup tab.
   a. Windows - Edit > Preferences.
   b. Mac OSX - MultiRack SoundGrid > Preferences.

2. Click on Load…

3. Browse to the desired *.mrrc file and click on Open.

4. Now the file is loaded onto the MultiRack Remote Controller Editor and the file location will appear like shown above.
5. Click on **Open Editor** to open the MultiRack Remote Controller Editor Window. There you will see a fully configured MIDI messages mapped to the software functions.

![Fully Controlled MultiRack Remote Controller Editor Window](image)

6. Click [OK] to close the SG MultiRack Preferences window.

**Please Note:** On Yamaha consoles such as the PM5D and DM/0, MIDI functions are assigned to the **User Defined Keys** of console for the *.mrrc file. Please View the Appendix, section A.2, to see which SG MultiRack Controls are set to which **User Defined Keys**.

This concludes the Automatic Mapping of the MultiRack Remote Controller Editor Window. On this window you'll be able to see exactly which MIDI Controller controls which function.
7.2 – Manual Mapping of the MultiRack Remote Controller Editor Window:

Once you have the Yamaha console MIDI Control fully configured, it is very simple to manually assign the Controls to where you want them on the console.

1. Launch the MultiRack Remote Controller Editor software.
   a. Mac – Applications > Waves > SoundGrid > MRRC Editor.
   b. PC – C:\Program Files(x86)\Waves\SoundGrid\MRRC Editor.

2. To map the MultiRack Remote Controller Editor simply highlight the Editor function you want mapped.

3. On the Yamaha console click/move the Encoder you want to control this function.

A notification for the Encoder’s ID will be shown under Midi Display in the MultiRack Remote Controller Editor window.
4. Repeat this process until you have completed configuring all the functions you want to control via the Yamaha Console.

5. Once a MIDI message has been mapped to a specific controller, it is displayed as shown below.

Don’t forget to set the **Prev Page** and **Next Page** controls so you’ll be able to browse between the plug-in parameters, for plug-ins such as EQ, Reverb or any other multi parameter plug-in.

On Yamaha consoles such as the PM5D, M7CL and DM/0, MIDI functions can be assigned to the **User Defined Keys** of console.

These can be used for the following functions:

- Recall specific Snapshots (the 8 Hot Snapshots of MultiRack).
- Recall the Next or Previous Snapshot.
- Navigate around the Racks and Plug-ins.
- Quick view of the 8 Hot Plug-ins.

These functions can be very useful for getting to specific plug-ins such as Delay or the Varies Effects you use in your show frequently, or get to specific Snapshots frequently used.
**Please Note:** When setting the **SNAPSHOT RECALL** Section, bear in mind that when you are use the Yamaha console Scene Control, the MultiRack Snapshot will follow to the Scene Control exact number. Meaning if you switch to Scene 2 on the Yamaha console, the MultiRack Snapshot will go back to Snapshot 2!

6. When editing is completed, click on **Save** on the bottom of the MultiRack Remote Controller Editor window and save the Remote Controller Setup to a new file.

*Pay attention to the location where you choose to save your *.mrrc file at. Furthermore, give it a name and location that is easily remembered.*

7. Exit the editor window.

Now we want to load the Remote Controller Setup file you have created in the MultiRack Remote Controller Editor window

1. In the **MultiRack** software, open the **Preferences** window and go to the **Control Setup** tab.
   a. Windows - **Edit > Preferences**.
   b. Mac OSX - **MultiRack SoundGrid > Preferences**.

2. Click on **Load…**

3. Browse Remote Controller Setup *.mrrc file you have created and click on **Open**.

4. Click on **Open Editor** to open the MultiRack Remote Controller Editor window and make sure that it is indeed set to the desired mapping.

5. Go back to the SG MultiRack window and click [OK] to close the Preferences window.

This concludes the Manual Mapping of the MultiRack Remote Controller Editor window.
8.0 Implementing the Yamaha Console MIDI mapping with the SG MultiRack:

In your SG MultiRack's session you will be able to see which plug-ins parameters are assigned to Plug-Ins Controls.

Bear in mind that you can only use 8 Encoders and Switches for Plug-in Control at a time.

You are able to see which Encoders are set to which Plug-in parameters by selecting the View > Show Controller Strip in the SG MultiRack menu bar.

These can be seen at the bottom of the screen. Only one plug-in is visible at any time, so it is always clear which plug-in is being controlled.

As a parameter is adjusted, its value is displayed, just like the Threshold parameter on the H-Comp above.

To move between the various plug-in parameters with the Yamaha Console Midi Control we set the Prev Page and Next Page controls.
The Plug-in parameters which are assigned to MIDI Controllers will be highlighted Red as shown below. Furthermore, the Plug-ins Parameter Page number will be displayed on the *Controller Strip*.

Example – Q10 EQ Controlled By Yamaha Console Viewing Two Plug-in Parameters Pages.

The 8 Encoders and Switches assigned Plug-in Controls are visible on only under *Rackview Mode* as shown above.

Use the *Prev Page* and *Next Page* controls to access extra functions when the plug-in has more than 8 parameters available.
Appendix

A. Remote control assignments of Yamaha PM5D, DM2000, DM1000 consoles.

A.1 – Plug-in and Racks Parameters Control.

This will cover which of the Plug-in and Racks parameters will be controlled via these Yamaha consoles when using the *.mrrc temple files.

<table>
<thead>
<tr>
<th>Continuous Plug-In Control</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5D MIDI Remote Encoders</td>
<td>Ch1</td>
<td>Ch2</td>
<td>Ch3</td>
<td>Ch4</td>
<td>Ch5</td>
<td>Ch6</td>
<td>Ch7</td>
<td>Ch8</td>
</tr>
<tr>
<td>DM2000 Remote Layer Bank 4 Encoders</td>
<td>Ch1</td>
<td>Ch2</td>
<td>Ch3</td>
<td>Ch4</td>
<td>Ch5</td>
<td>Ch6</td>
<td>Ch7</td>
<td>Ch8</td>
</tr>
<tr>
<td>DM1000 Remote Layer Bank 4 Encoders</td>
<td>Ch1</td>
<td>Ch2</td>
<td>Ch3</td>
<td>Ch4</td>
<td>Ch5</td>
<td>Ch6</td>
<td>Ch7</td>
<td>Ch8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Discrete Plug-In Control</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5D MIDI Remote Encoder On Switches</td>
<td>Ch1</td>
<td>Ch2</td>
<td>Ch3</td>
<td>Ch4</td>
<td>Ch5</td>
<td>Ch6</td>
<td>Ch7</td>
<td>Ch8</td>
</tr>
<tr>
<td>DM2000 Remote Layer Bank 4 On Switches</td>
<td>Ch1</td>
<td>Ch2</td>
<td>Ch3</td>
<td>Ch4</td>
<td>Ch5</td>
<td>Ch6</td>
<td>Ch7</td>
<td>Ch8</td>
</tr>
<tr>
<td>DM1000 Remote Layer Bank 4 On Switches</td>
<td>Ch1</td>
<td>Ch2</td>
<td>Ch3</td>
<td>Ch4</td>
<td>Ch5</td>
<td>Ch6</td>
<td>Ch7</td>
<td>Ch8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Other Plug-In Controls</th>
<th>Prev Page</th>
<th>Next Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5D MIDI Remote Channel On Switches</td>
<td>Ch7</td>
<td>Ch8</td>
</tr>
<tr>
<td>DM2000 Remote Layer Bank 4 On Switches</td>
<td>Ch9</td>
<td>Ch10</td>
</tr>
<tr>
<td>DM1000 Remote Layer Bank 4 On Switches</td>
<td>Ch9</td>
<td>Ch10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rack Controls</th>
<th>Input Gain</th>
<th>Output Gain</th>
<th>On / Off</th>
<th>In / Out</th>
<th>Mute</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5D MIDI Remote</td>
<td>Ch1 Fader</td>
<td>Ch2 Fader</td>
<td>Ch1 On</td>
<td>Ch2 On</td>
<td>Ch3 On</td>
</tr>
<tr>
<td>DM2000 Remote Layer Bank 4</td>
<td>Ch15 Fader</td>
<td>Ch16 Fader</td>
<td>Ch14 On</td>
<td>Ch15 On</td>
<td>Ch16 On</td>
</tr>
<tr>
<td>DM1000 Remote Layer Bank 4</td>
<td>Ch15 Fader</td>
<td>Ch16 Fader</td>
<td>Ch14 On</td>
<td>Ch15 On</td>
<td>Ch16</td>
</tr>
</tbody>
</table>
A.2 - MIDI functions Assigned to User Defined Keys of these Yamaha consoles.

This will cover the MIDI functions are assigned to the User Defined Keys of the Yamaha consoles when using the *.mrrc temple files.

These are used for the following functions:

1. Recall specific Snapshots (the 8 Hot Snapshots of MultiRack).
2. Recall the Next or Previous Snapshot.
3. Navigate around the plug-ins.
4. View the 8 Hot Plug-ins of MultiRack.

This will cover which of the following functions will be controlled by the User Defined Key assignments of these Yamaha consoles when using the *.mrrc temple files.

**NAVIGATION Section:**

<table>
<thead>
<tr>
<th>Hot Plug-Ins</th>
<th>#1</th>
<th>#2</th>
<th>#3</th>
<th>#4</th>
<th>#5</th>
<th>#6</th>
<th>#7</th>
<th>#8</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5D User Defined Bank A</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td>DM2000 User Defined Bank A</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td>DM1000 User Defined Bank A</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
</tr>
</tbody>
</table>

**Plug-In Navigation**

<table>
<thead>
<tr>
<th>PM5D User Defined Bank A</th>
<th>Up Rack</th>
<th>Down Rack</th>
<th>Prev Plug-in</th>
<th>Next Plug-in</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
</tr>
<tr>
<td>DM2000 User Defined Bank A</td>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
</tr>
<tr>
<td>DM1000 User Defined Bank A</td>
<td>9</td>
<td>10</td>
<td>-</td>
<td>11</td>
</tr>
</tbody>
</table>

**SNAPSHOT RECALL section:**

<table>
<thead>
<tr>
<th>Hot Snapshots</th>
<th>#1</th>
<th>#2</th>
<th>#3</th>
<th>#4</th>
<th>#5</th>
<th>#6</th>
<th>#7</th>
<th>#8</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM5D User Defined Bank B</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td>DM2000 User Defined Bank B</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td>DM1000 User Defined Bank B</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
</tr>
</tbody>
</table>

**Snapshot Recall**

<table>
<thead>
<tr>
<th>PM5D User Defined Bank B</th>
<th>Prev</th>
<th>Next</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM2000 User Defined Bank B</td>
<td>9</td>
<td>10</td>
</tr>
<tr>
<td>DM1000 User Defined Bank B</td>
<td>9</td>
<td>10</td>
</tr>
</tbody>
</table>
**B. Remote control assignments of Yamaha M7CL, LS9 and CL Series consoles.**

This will cover which of the following functions will be controlled by the **User Defined Key** assignments of these Yamaha console when using the *.mrrc* temple files.

<table>
<thead>
<tr>
<th>Discrete Plug-in Controls</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Change Number</td>
<td>103</td>
<td>104</td>
<td>105</td>
<td>106</td>
<td>107</td>
<td>108</td>
<td>109</td>
<td>110</td>
</tr>
<tr>
<td><strong>M7CL Send On to Mix16</strong></td>
<td>Ch1</td>
<td>Ch2</td>
<td>Ch3</td>
<td>Ch4</td>
<td>Ch5</td>
<td>Ch6</td>
<td>Ch7</td>
<td>Ch8</td>
</tr>
<tr>
<td><strong>CL Series Send On to Mix16</strong></td>
<td>Ch1</td>
<td>Ch2</td>
<td>Ch3</td>
<td>Ch4</td>
<td>Ch5</td>
<td>Ch6</td>
<td>Ch7</td>
<td>Ch8</td>
</tr>
<tr>
<td><strong>LS9 Send On to Mix16</strong></td>
<td>Ch1</td>
<td>Ch2</td>
<td>Ch3</td>
<td>Ch4</td>
<td>Ch5</td>
<td>Ch6</td>
<td>Ch7</td>
<td>Ch8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Continuous Plug-in Controls</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Change Number</td>
<td>111</td>
<td>112</td>
<td>113</td>
<td>114</td>
<td>115</td>
<td>116</td>
<td>117</td>
<td>118</td>
</tr>
<tr>
<td><strong>M7CL Send Level to Mix16</strong></td>
<td>Ch1</td>
<td>Ch2</td>
<td>Ch3</td>
<td>Ch4</td>
<td>Ch5</td>
<td>Ch6</td>
<td>Ch7</td>
<td>Ch8</td>
</tr>
<tr>
<td><strong>CL Series Send On to Mix16</strong></td>
<td>Ch1</td>
<td>Ch2</td>
<td>Ch3</td>
<td>Ch4</td>
<td>Ch5</td>
<td>Ch6</td>
<td>Ch7</td>
<td>Ch8</td>
</tr>
<tr>
<td><strong>LS9 Send Level to Mix16</strong></td>
<td>Ch1</td>
<td>Ch2</td>
<td>Ch3</td>
<td>Ch4</td>
<td>Ch5</td>
<td>Ch6</td>
<td>Ch7</td>
<td>Ch8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Other Plug-in Controls</th>
<th>Prev Page</th>
<th>Next Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Change Number</td>
<td>102</td>
<td>119</td>
</tr>
<tr>
<td><strong>M7CL Send On to Mix16</strong></td>
<td>Ch9</td>
<td>Ch10</td>
</tr>
<tr>
<td><strong>CL Series Send On to Mix16</strong></td>
<td>Ch9</td>
<td>Ch10</td>
</tr>
<tr>
<td><strong>LS9 Send On to Mix16</strong></td>
<td>Ch9</td>
<td>Ch10</td>
</tr>
</tbody>
</table>

**Please Note:** note that there are no controls on the console for the Hot Plug-in and Hot Snapshot selections this time.

As an alternative, some keys on the host computer keyboard can be assigned to Hot Plug-ins and Hot Snapshots (see the MultiRack SoundGrid manual for further details).